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1. RemoteView for iPhone/iPad Overview 
 

1.1 What is RemoteView for iPhone/iPad? 
 

RemoteView for iPhone/iPad is an application that can be downloaded from the MAC App Store, 
used to quickly connect and control a *registered remote PC or Server. 

 
*Registered machines are those with the RemoteView 5.0 Agent program installed on their system. 

 
1.2 Minimum Device & OS Requirements 

 

 Minimum Recommended 

Operating 
System 

iOS 6 or later iOS 6 or later 

Storage 10.3 MB 

Connection 3G, 4G LTE, WiFi 

 
1.3 RemoteView Agent Requirements 

 
Windows Requirements: 

 

 Minimum Recommended 

Operating 
System 

Windows®  Vista 
Windows®  Vista or later (32-bit or 

64-bit) 
CPU Intel®  Pentium™ 4 [1.4 GHz] Intel®  Pentium™ 4 [2.0 GHz] 

Memory 256 MB RAM 512 MB RAM 
Storage 50 MB available HD space 100 MB available HD space 

Web Browser 
Internet Explorer®  7.0 or later 

(32bit only) 

Internet Explorer®  8.0 or later 
Firefox 3.5 or later 
Chrome 7.0 or later 
Safari 4.0 or later 

Network 
Modem, ADSL, LAN, Public IP, and Private IP (Wireless Networks 

Supported) 
Firewall Outbound Ports 80(http) / 443(https) Open 

 
    MAC Requirements: 

 

 Minimum Recommended 

Operating 
System 

Mac OS X 10.7 Mac OS X 10.8 

CPU Intel based CPU 

Memory 256 MB RAM 512 MB RAM 

Storage * RemoteView Agent not supported 

Web 
Browser 

Safari 3.2 
FireFox 3.0 

Safari 4.0 
FireFox 3.5 

Network 
Modem, ADSL, LAN, Public IP, and Private IP (Wireless Networks 

Supported) 

Firewall Outbound Ports 80(http) / 443(https) Open 
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2. Installing the RemoteView App for iOS 
 

2.1 Installing from the mobile device 
 

Connect to the App Store from your iPhone/iPad/iPad and search for the keyword “RemoteView” 
and follow the on screen instruction to install the product. 
 

 
2.2 Installing via iTunes 

 
Download and install iTunes onto a PC or Mac. Open iTunes and search for the keyword 
“RemoteView” and download the application. Once your Apple device becomes synced with iTunes, 
RemoteView will be downloaded and installed onto your device automatically. 
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3. Uninstalling RemoteView for iPhone/iPad 
 

3.1 Uninstalling RemoteView from the Mobile Device 
 

Press and hold the RemoteView icon for 2 seconds. Once the app icons start jittering, tap the “X” 
button to remove RemoteView from the mobile device. Tap the “X” button will prompt a confirmation 
message asking if you want to delete RemoteView. Tap “Delete” to continue and uninstall 
RemoteView entirely. 
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3.2 Uninstalling RemoteView through iTunes 
 

Go to iTunes > Library > Apps > iPhone and use the App Manager to locate and remove 
RemoteView from your iOS device. Once you have successfully deleted RemoteView, click “Apply” 
to sync your device with iTunes and update your device with your newly applied changes. 
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4. Getting Started with RemoteView for iPhone/iPad 
 

4.1 Launching RemoteView for iPhone/iPad 
 

Tap the RemoteView icon from your home screen to launch the RemoteView application. Once 
RemoteView opens, select the appropriate service you signed up and tap “Next” to continue, and 
login. 
 

           
 

                       
 

    
4.2 Logging into RemoteView 

 
After launching the RemoteView app, enter the account information you used when setting up your 
account from the homepage (https://www.rview.com/) to login. 

 
Enter your User ID and Password and tap “Login.” Once you’ve successfully logged into your 
RemoteView account, you will see your Groups and registered computers listed. 
 

 

https://www.rview.com/


 

 

© 2001-2017 RSUPPORT Co., Ltd. ALL RIGHTS RESERVED. [www.rsupport.com] 

 

10 

Toggle “Save User Info” ON to store your account information for future use. 
 

              
 

Note: The RemoteView login information is case-sensitive so be sure to verify the information you 
entered if you fail to login. 

 

※ Warning: You may not be able to login or connect in areas with a weak or unstable network 

signal. 
 
  



 

 

© 2001-2017 RSUPPORT Co., Ltd. ALL RIGHTS RESERVED. [www.rsupport.com] 

 

11 

4.3. 2-Step Authentication, Google OTP (One Time Password) 
           

     After you enter your credentials for RemoteView, you will need to use 2-Step Authentication, and 
enter a Google OTP.  
 
 
 

     
<Enter your account         <Enter OTP code> 
Information, and press 
‘log-in.’> 
 
 
*These are set options for RemoteView Enterprise licenses. 
 
 
*Note: For more information, Google OTP is also mentioned in the RemoteView Enterprise ASP User 
Guide. 
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4.4 RemoteView for iPhone/iPad – About Menu 
 

Tap  at the top left-hand side of the Login Screen to access the About Menu. 
 
Here you’ll see App Version, License Info, MAC Address, Tutorial, Notices, as well as a Settings 
Menu. Settings include Language, Product Type (Personal, Business, and Server) and Proxy 
Information. 
 

Tap  to exit the About Menu. 
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4.4.1 Basic Information 

4.4.1.1 App Version 
 

This displays the version of the installed RemoteView app. 
    

 

4.4.1.2 License Version 
 

Tap ‘License Info’ to view the RemoteView Open Source Agreement. Tap  to go back to 
the About Menu. 
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4.4.1.3 Mac Address 
 

The iOS device’s MAC address will be displayed here. Tap  to copy the MAC address 
onto the clipboard. 
 

       
 
Note: For devices running iOS 7 or later, RemoteView for iOS will provide an alternate 
MAC address. The MAC address listed here can be used to additional setup security 
settings within RemoteView. 

 
 

 
 

       
 



 

 

© 2001-2017 RSUPPORT Co., Ltd. ALL RIGHTS RESERVED. [www.rsupport.com] 

 

15 

4.4.1.4 Tutorial 
 

Tap ‘Tutorial’ to view the tutorial again. 
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4.4.1.5 Notices 
 

Tap ‘Notices’ to view a list of all notices that have been posted for RemoteView. Tap on a 
specific notice to view additional information. 
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4.4.2 Settings 

4.4.2.1 Language Settings 
 

The RemoteView app for iPhone/iPad currently supports English, Korean, Japanese, 
Chinese (Simplified), and Chinese (Traditional). 
 
The display language will correspond with the language that is used within iOS. To 
change the iOS display language, follow the steps below: 
 
Navigate to Settings > General >Language & Region. Select the desired language and 
tap ‘Done’ to apply changes, if you choose to change the language. 
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4.4.2.2 Product Settings 
 

Select the appropriate RemoteView Product (Standard/Enterprise or Server) you have 
signed up for. 

 
Note: It is not recommended you edit the Server Address Settings unless specifically 
instructed by an Rsupport representative. 
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4.4.2.3 Proxy Information Settings 
 

To connect through a proxy server it must be configured within your iOS device.  
 
Navigate to Settings > Wi-Fi > Network Name > HTTP Proxy > Manual. Enter the 
necessary information and follow the steps below to connect through the proxy server. 
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4.4.3  More 

4.4.3.1 Tell a Friend 
 

Tell your friends about RemoteView for the iPhone/iPad by sending them an email. Tap 
“Tell a Friend” in the About Screen to send them a pre-written email, or write your own 
message. 

 
The recipient will be able to download the RemoteView Mobile app from iTunes by 
clicking the download link and learn more about RemoteView by selecting the links 
below. 
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4.4.3.2 Feedback 
 

Contact RemoteView support directly by sending us a comment. If you ever experience 
any difficulty while using RemoteView, simply tap ‘Feedback’. 
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4.5 List of Remote PCs 
 

4.5.1 Registered PCs 
 

After a successfully logging into the RemoteView app, a list of registered computers will be 
displayed individually, or in groups. Total number of PCs and groups are shown on the top. 

 
The RemoteView will display Virtual environments if the RemoteView Agent program has 
been installed into one. VMware (VMware. Inc.), Hyper-V / Virtual PC (Microsoft), Virtual 
Box (Oracle), Xen (Citrix) and more are all compatible with RemoteView for the 
iPhone/iPad. 

 

          
 

Please refer to the icons below to check the status of your remote registered 
computers. 

 

Icon Description 

 

Agent or Remote PC is turned off. A remote connection is unable to 
be established. 

 

Agent and Remote PC are online.  The remote computer is ready 
for remote connection. 

 

RemoteView license has expired. A remote connection is unable to 
be established. 

 

The maximum number of registered computers has been exceeded. 
A remote connection is unable to be established. 

 

Tap  to refresh the status of the remote computers. 
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4.5.2 Using the Search Function 
 

If you have a large number of registered computers on your account, use the Search 
function to find a specific computer. Pan the screen up to find the Search box. 

 

 
 

4.5.3 Remote Options 
 

Tap  on the right of the registered computer to bring up the Remote Options Menu. 
Check connectivity, take a remote screenshot, view system properties, log off, shutdown, 
or restart the remote computer. 
 

       
 



 

 

© 2001-2017 RSUPPORT Co., Ltd. ALL RIGHTS RESERVED. [www.rsupport.com] 

 

24 

 Remote Control 
 

Access the Remote Options Menu and tap “Remote Control” to bring up the Login 
Screen. Enter your RemoteView account information and tap “Connect” to initiate a 
remote session. 
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 Check Connectivity (Refresh) 
 

Check the connection status of your registered computers by utilizing one of the four 
methods shown below. 
 

A. Tap on the icon of any offline remote computer. 
B. Go to any remote computer’s Remote Options Menu and Tap ‘Check 

Connectivity (Refresh). 

C. Refresh all remote computers’ connectivity status by tapping the   button 
towards the top of the screen. 

D. Select a remote computer and swipe the icon towards the right. 
 

       
 

        

A B 

C D 
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 Remote Power ON (WOL) 
 

Access the Remote Options Menu and tap “Power on (WOL)” to remotely power on the 
specified computer. Enter your RemoteView account information and tap “Connect” to 
turn on the remote computer and initiate a remote session.  

 

     
 

 vPro Power Management 
 

Access the Remote Options Menu and tap “vPro Power Management” to remotely 
power on the selected computer using Intel’s vPro technology. Enter your RemoteView 
account information and tap “Connect” to turn on the remote computer and initiate a 
remote session. 
 
Please refer to section 4.6 vPro Power Management for more information. 

 
Note: This feature is only available for RemoteView Enterprise users. 
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 Remote Screenshot 
 

Access the Remote Options Menu and tap “Screen Capture” to take a screenshot of 
the selected computer’s screen. Enter your RemoteView account information and tap 
“Connect” to connected to the selected computer and take a screen shot. 

 
All screenshots will be stored in your Photo Album. Navigate to Photos > Camera Roll > 
and tap the thumbnail of the desired screenshot to view it. 
 

     

 System Properties 
 

View basic system information of the selected remote computer by tapping “Properties”. 
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 Log off / Shutdown / Restart 
 

You’re able to remotely log off, shutdown, or restart the remote computer through the 
Remote Options Menu. Enter your RemoteView account information and tap “Connect” 
to execute the selected command. 
 

     
 

 Removing an Agent 
 

Access the Remote Options Menu and tap on “Remove Agent” to uninstall and 
unregister the selected computer from your account. Enter your RemoteView account 
information and tap “Connect” to remove the RemoteView agent from the selected 
computer. 
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4.6. vPro Power Management 
 

A PC with vPro support can be shutdown and powered up remotely. In order to use vPro feature, 
Intel vPro must be installed in the motherboard. Also, as direct control of vPro is not possible 
through the mobile device, a vPro accessible PC must be available in the same network. 
 
vPro Supported Products: RemoteView 5.0 Server, RemoteView Season 2 ASP Premium, 
RemoteView Season 2 Server 
 
If a computer is vPro compatible, the “vPro Power Management” feature will be available on the 
Remote Options Menu. Enter your RemoteView account information to take advantage of Intel 
vPro’s power management capabilities. 
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Item Description 

ID Enter vPro’s ID. 

Password Enter vPro’s password 

Gateway Enter the name of the Gateway PC from the same network. 

Power 
Management 

Select from Restart, Turn On and Turn Off [Pic. 27]. 

Run Run commands. 

 

※ Note: restarting or shutting down the PC using vPro will not save the information as a normal 

Windows shutdown operation, and may results in data loss or program corruption. 
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4.7. Logging In 
 

Once you have logged in successfully, your registered computers and management groups will be 
listed. 
 
Tap on the remote computer and log in by entering your User ID and Password. If this is the first 
time you are logging in, the RemoteView Quick Guide will be displayed for you. This screen 
contains the basic gestures used to remote control your selected computer. 
 
Uncheck “Always Display” if you do not wish for this guide to be displayed again in the future. 
 

     
 

※ Warning: Using your 3G data plan may incur additional data fees from your cell phone 

carrier. 
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5. Remote Control 
 

Once the remote session has been established successfully, use your finger as the mouse. The Remote 
Control Menu will be displayed by default. 
 

If the Remote Control Menu is minimized, tap  to bring up the Remote Control Menu. 
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5.1. Mouse Controls 

 

5.1.2 Touch Mode / Virtual Mouse Mode 
 

In Touch Mode, the mouse cursor will not be visible on the screen. Tap anywhere on the 

desktop to display the tracker ( ). 

Within the Remote Control Menu, tap  to toggle the Virtual Mouse Mode. To return to 

Touch Mode, tap   again. Refer to the following section to learn more about mouse 
controls. 
 

       
 

       
            <Virtual Mouse Mode>               <Touch Mode> 
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Event 
Control Methods 

Touch Mode Virtual Mouse Mode 

Cursor 
None 

(  Displays with tab) 

 
 
 

Left Click Tap the screen with one finger. 

 
Tap the screen in area other than  
the cursor with 1 finger. 
 

Right Click 

1. Tap and hold the screen for 
approximately 2 seconds. 

2. Tap the screen with two 
fingers. 

1. Tap the screen with one finger 
2. Tap the screen in any area other 

than the cursor and hold for 
approximately 2 seconds. 

3. Tap the screen in any area other 
than the cursor with 2 fingers. 

Double Click 
 
Quickly double-tap the screen. 
 

Zoom In / Out 
 
Pinch to zoom in and expand to zoom out. (Default iPhone Function) 
 

Move Screen 
Use your finger and swipe to the 
left or to the right. 

 
Move the cursor to the right or left 
edge of the screen. 
 

Mouse Drag 
 
Tap and drag the object. 
 

 
Tap and hold until the cursor turns blue, 

then drag . 
 

Window 
Scrolling 

 
1. Use the Virtual Scroll Wheel on the right-hand side of the screen. 
2. Tap and drag using two fingers. 

 

Windows 8 Menu 

 
1. Switch Metro UI /Desktop: Drag up 
2. Windows 8 Toolbar: Swipe right to left 

 

Monitor Switch 
 
Swipe the screen using 3 fingers. 
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5.2. Keyboard Control 
 

Tap  to bring up the virtual keyboard. 
 

Tap  once to toggle “Indirect Input Mode”. Tap  again to toggle “Direct Input Mode”. Tap 

  once to bring up the functions keys and tap   again to close it. To close the virtual 

keyboard, tap . 
 

         
 
  [Direct Input Mode]        [Indirect Input Mode]         [Function Keys] 

 
 
 

Note: When connected to a MAC,  will be replaced by , and  will be replaced by . 

Additionally,  will be replaced by  and  will be replaced by . 

Item Description 

Direct Input 

 
All keyboard inputs are sent to the remote computer in real-time. 

Use  keys to utilize Windows shortcuts. 
 

Indirect Input 

 
Typed characters will be first shown on the top bar then send them to the 

remote computer by tapping . 
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5.3. Screen Control Menu 
 

Tap  from the Remote Control Menu to bring up the Screen Control Menu. Refer to the chart 
and images below to learn more about each of the menu options. 
 

           
 
                             [Freeze Screen Move ON]     [Screen Rotation OFF] 
 
 

Item Function Description 

Screen 

Switch Monitor 
When accessing a remote multi-display 
system, use “Switch Monitor” to select 
the desired work environment. 

Freeze Screen Move [ON / OFF] 

Toggle “Freeze Screen Move” ON to lock 
the screen in its current position. Toggle 
“Freeze Screen Move” OFF to pan 
across the remote desktop freely. 

Screen Rotation [ON / OFF] 

Toggle “Screen Rotation” ON to enable 
landscape view on the mobile device. 
Toggle “Screen Rotation” OFF to disable 
landscape view on the mobile device. 

Remote Screen Lock [ON / OFF] 

Toggle “Remote Screen Lock” ON to lock 
the remote computer screen. Toggle 
“Remote Screen Lock” OFF to unlock the 
remote computer screen. 

Remote Screen Capture 
Tap “Remote Screen Capture” to take a 
screenshot of the remote desktop. 

Fit to Device Screen 
Tap “Fit to Device Screen” to fit the entire 
desktop onto the device display. 

  
Fit to Default Screen 

 

Tap “Fit to Default screen” to fit onto PC 
screen 
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5.4. Window Menu 
 

Tap  from the Remote Control Menu to bring up the Window Menu. Refer to the chart and 
images below to learn more about each of the menu options. 
 

 
 

Item Function Description 

Window 

Close Window 
 
Closes the current window. 
 

Minimize Window 
 
Minimizes the current window. 
 

Maximize Window 
 
Maximizes the current window. 
 

Switch Windows (Alt + Tab) 
 
Cycles through all open windows. 
 

Shortcut to Desktop 

 
Automatically brings the user to the 
remote desktop. 
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5.5. Tools Menu 
 

Tap  from the Remote Control Menu to bring up the Tools Menu. Refer to the chart and 
images below to learn more about each of the menu options. 
 

           
 
                              [Windows Applications]        [MAC Applications] 
 
 

Item Function Description 

Tools 

Connection Information (Session 
Information) 

View information about the current 
remote connection. 

Process Information 

View information about processes 
currently running on the remote 
computer. 
 
This option will not be available when 
accessing a MAC system. 

 

System Information 

View the remote computer’s system 
information. 
 
This option will not be available when 
accessing a MAC system. 

 

Launch Application 

Remotely launch various applications or 
launch applications manually. 
 
Windows: Notepad, Explorer, MS Paint, 
Calculator, Command Prompt 
 
MAC: TextEdit, Finder, Calculator, 
Safari. 

Log Off Logs off the remote computer. 
Restart Restarts the remote computer. 

Shutdown Shuts down the remote computer. 
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5.6. Shortcuts Menu 
 

Tap  from the Remote Control Menu to bring up the Tools Menu. Refer to the chart and 
images below to learn more about each of the menu options. 
 

         
 
      [Windows Shortcuts]                      [MAC OS X Shortcuts] 
 

 

Item Windows MAC OS X 

Shortcuts 

Ctrl + Alt + Del 
(Task Manager) 

Alt + Cmd + Esc 
(Task Manager) 

Ctrl + C (Copy) Cmd + C (Copy) 
Ctrl + V (Paste) Cmd + V (Paste) 
Ctrl + X (Cut) Cmd + X (Cut) 

Ctrl + A (Select All) Cmd + A (Select All) 
Alt + F4 (Close Window) Cmd + Q (Close Window) 
Win + D (Go to Desktop) F11 (Desktop) 

Win + L (Lock)  
Win + E (Explorer)  

Win + R (Run) (Search) 
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5.7. Settings Menu 
 

Tap  from the Remote Control Menu to bring up the Tools Menu. Refer to the chart and 
images below to learn more about each of the menu options. 
 

 
 
 

Item Function Description 

Settings 

Quality 
(Best Speed / Best Graphics) 

 
View information about the current 
remote connection. 
 

 
Color 

(B&W / 256 Color / High Color) 
 

 
Manage color settings on the remote 
computer. 

Resolution 
Manage the remote computer’s 
resolution. 
 

Start Remote Sound 
[ON / OFF] 

Toggle “Start Remote Sound” ON to 
enable remote sounds to emit from the 
local computer. Toggle “Start Remote 
Sound” OFF to disable remote sounds. 

View Control Tips 
Displays tips for “Touch Mode” and 
“Virtual Mouse Mode”. Set tips to be 
hidden or displays. 
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5.8. Exiting the App 
 

Tap  from the Remote Control Menu to disconnect from the remote computer. Tap “OK” to 
the confirmation message to end the remote session. 
 

 
 
 

5.9. Exiting the Application 
 

To exit the RemoteView for iPhone/iPad application, double-tap the Home button to bring up the 
multi-tasking screen. Locate the RemoteView app and swipe up on the thumbnail to exit the 
application. 
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6. Switching Between Apps in a Remote Session 
 

6.1 Access other app during remote session 
 

To use other app while in a remote session, press the “Home” button to have RemoteView run in 
the background and open another application. 
 

※ Warning: Using your 3G data plan may incur additional data fees from your cell phone carrier. 

 
6.2 Receiving Phone Calls 

 
If an incoming phone call is answered while in a remote session the remote session will close 
automatically. In order to access the remote computer afterwards, you will need to login. 
 
6.3 Receiving SMS 

 
If you receive a SMS message while in a remote session you will receive a notification. Press 
“Close” to stay connected to the current session, or “OK” to end the session and read the message. 
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For more information about RSUPPORT, please visit 
http://www.rsupport.com  
 

Korea : 
 

서울특별시 송파구 위례성대로 1 (에스

타워 11, 12, 15층) 

전 화 : +82-70-7011-3900 

팩 스 : +82-2-479-4429 

기술문의 : support.kr@rsupport.com 

구매문의 : sales.kr@rsupport.com 

기타문의 : info.kr@rsupport.com  

 

 

Japan : 
 

〒105-0001 

東京都港区虎ノ門1-2-20 第3虎の門電

気ビル 

TEL : +81-3-3539-5761 

FAX : +81-3-3539-5762 

お問い合わせ : support.jp@rsupport.co

m 

Sales : sales.jp@rsupport.com 

Info : info.jp@rsupport.com  

 

 

USA : 
 
560 Sylvan Ave, Suite 1000 

Englewood Cliffs, NJ 07632 

Phone : +1-888-348-6330 

Fax : +1-888-348-6340 

Tech : support.us@rsupport.com 

Sales : sales.us@rsupport.com 

Info : info.us@rsupport.com 

 

 

China : 
 

北京市朝阳区阜通东大街 6号方恒国际 A座 2708 

咨询电话 : +86-10-8256-1810 

联系邮箱 : co-china@rsupport.com 
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